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License Agreement for VSLogix Software

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE.

By using the VSLogix software and any associated hardware, you agree to the terms outlined in this License
Agreement. Your use of the software constitutes acceptance of these terms.

1. Intellectual Property Rights

VSLogix software and accompanying tools are protected by copyright laws and international intellectual
property treaties. Unauthorized reproduction, distribution, or modification of this software is strictly prohibited
and may result in civil and criminal penalties. Vital Systems reserves the right to pursue legal action to the fullest
extent permitted by law.

2. Acknowledgement of Risk and Responsibilities
You acknowledge that all mechanical and electrical systems inherently involve hazards. By using the VSLogix
software and associated hardware in conjunction with any machine or device, you agree to the following:

e You, as the user, accept full responsibility for its operation and any associated risks.

e You agree that neither Vital Systems nor its affiliates, distributors, or partners will be held liable for any
damages, injuries, losses, or other misfortunes resulting from the use or misuse of the VSLogix
software or any associated hardware.

e You acknowledge that while every effort is made to ensure the software operates correctly and
reliably, no software is completely free of bugs or errors. You accept that any errors, faults, or
unintended behavior of the software—whether due to system bugs, hardware malfunctions, or
operator errors—are your responsibility.

3. Waiver of Liability
By agreeing to this License Agreement, you explicitly waive any claims against Vital Systems and its affiliates for:
e Anydirect or indirect damages, including but not limited to material loss, injury, or secondary damages,
caused by the use of the software.
e Any errors or operational faults that arise from the use of VSLogix or its associated hardware.
You agree to indemnify and hold harmless Vital Systems and its affiliates from any and all claims, damages, or
liabilities arising from the use or inability to use the software.

4. User Responsibilities

e You are solely responsible for ensuring the safe operation of the software and associated hardware,
both by yourself and by any other individuals who may use it.

e Itis your responsibility to inform any operators or personnel working with or near machines controlled
by VSLogix of any limitations or potential risks associated with the software.

e You agree to comply with all applicable safety procedures and regulations in your jurisdiction, including
but not limited to standard operating procedures, industry safety guidelines, and any local laws related
to the safe operation of machinery and software.

5. Acceptance of Terms

By using VSLogix, you acknowledge that you have read, understood, and agree to the terms of this License
Agreement. You fully accept all responsibility for the operation of the software and associated hardware and
agree to ensure that all users of the system are aware of these terms.

© 2025 Vital Systemes, Inc. 4 www.VitalSystem.com
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l. Introduction

Fie Vi Tock  Help

Muster Status

(W o |
(ONGNEDRZ 681 91

VSLogix is a graphical and feature-rich ladder-logic programming environment for the IntellECAT
PLC/Gateway. It has been developed to meet industrial programming standards for many specialized
applications. VSLogix serves as a direct interface to the IntellECAT gateway and its connected
network. It allows for the writing, configuration, and real-time monitoring of ladder programs, as well
as the current status and 1/0 of all connected GX20 control cards.

VSLogix Features:

e Create robust, powerful, and reusable ladder-logic programs and download them to devices.
e Upload and modify existing ladder-logic programs directly from the IntellECAT gateway.

e Scan and Configure GX20 network through the IntellECAT gateway.

e Monitor program execution and debug programs by changing values during runtime.

e Drag-and-drop Graphical User Interface for simple yet extensive ladder-logic programming.

IntellECAT Features:

e |n Gateway mode provides Ethernet access to a network of up to 128 GX20 control cards.

e In PLC mode, can run up to 32 ladder programs controlling up to 64 GX20 control cards or 10
Smart3G cards.

Supported Network Hardware:

GX20 GX20 has two 24V Motor outputs M8 5-Pin plugs with speed & direction control,
and two photo-eye M8 4-Pin plugs. GX20 control card sends Voltage, Current,
I/0 states, and Speed data back to the IntellECAT Gateway for use in Ladder
Programs or by a Master PLC (Rockwell etc).

Smart3G Useful where you need screw terminals for 24V digital 1/O (8 in, 8 out)

Octo24 IP67 Hardware for liquid-proof /O control 24V digital I/O (8 in, 8 out)

© 2025 Vital Systemes, Inc. 5 www.VitalSystem.com



http://www.vitalsystem.com/

MTAL

= 5ystems inc EtherCAT. IntelleCAT PLC/Gateway

Il. Basic Concepts

The IntellECAT gateway can control up to 128 GX20 control cards and up to 10 Smart3G/OCTO cards.
How these devices will be controlled depends on which of two modes the IntellECAT is in.

Gateway Mode

In Gateway Mode, devices will be controlled directly by a connected Master PLC. No ladder programs
will run on the IntellECAT gateway itself. The IntellECAT will simply act as a gateway to the GX20
network for a connected Ethernet/IP Master. Depending on the model of IntellECAT, you may still
need to configure the IntellECAT’s device list and download the VSLogix project to the device. Use of
the Network Browser is the quickest and easiest way to accomplish this. Refer to the Protocols section
for specific information on the recommended Ethernet/IP settings and message format for the Master
PLC.

© 2025 Vital Systemes, Inc. 6 www.VitalSystem.com
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PLC Mode Types

In PLC Mode, devices on network are controlled
by Ladder programs running inside the
IntellECAT Gateway. These are created using Accumulation Divert
the Ladder Editor. The IntellECAT gateway can
store up to 32 different Ladder Programs at a

time. There are two types of Ladder Programs: S :
ections
Main Ladder
There is one Main Ladder in every project. The Accianulation Interlocks
—

Main Ladder commands devices directly. It can
be used to develop conditions to be used
globally in every conveyor section (e.g., System
Start/Stop condition).

Accumulation
Conveyor Type (Ladder Template)
Conveyor Types are Ladder Programs that can
be instantiated multiple times as Conveyor
Sections. Instead of referring directly to device
addresses, Conveyor Types use placeholders. Accumulation
These placeholders are later mapped to actual
addresses when a Conveyor Section is created
from that type. This allows the user to create a
few different ladder programs and then reuse
them to design an entire conveyor line in a Accumulation
graphical view.

For example, one might create Accumulation,
Merge, and Divert programs and assemble
them into a Layout as seen on the right. Aearralkier

Conveyor Sections

Conveyor Sections are instances created from different Conveyor Types. In each conveyor section,
you can map the devices that will be used in that section. You can connect different conveyor sections
using interlock. The IntellECAT can have up to 31 Conveyor Sections at one time. Each Conveyor
Section is capable of controlling any number of GX20 control cards. However, you cannot exceed the
total max number of devices controllable by the IntellECAT (64 GX20, 10 Smart3G/OCTO).

Conveyor Layout

In the Conveyor Layout window, you can drag and drop conveyor types to create conveyor sections.
You can then assign GX20 control cards to those sections. These sections can also be connected to
one another using interlocks, establishing the overall flow of the conveyor system.

© 2025 Vital Systemes, Inc. 7 www.VitalSystem.com
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lll. User Interface
JX VSLogix v1.03: ¥SI* - [m] X

File View Tools Help
R ™ EE,‘ (8] Platform Intellecat -l ‘ugﬁﬂﬁEl' ﬂ‘ Device Online ‘ Monitoring Disabled H RAM(192/6144) ‘ 2| |

Project Explorer B3| F 1zoneAce | < x | [Toolbox (%

s B e o o

i Master Setiings Input Contacts P

i B Device List

- H Main Ladder

. - H 1zoneace
+.[#] conveyor Layout

{-Hlz 1ZoneAcc 0
Hlz 1ZoneAce 1

ONLINE [192.168.1.97]

= Conveyor Types (1/31)

=@l Conveyor Instances (2]

Start Up Run Photo Eye 1

4k NO Contact
- NC Contact
22 Compare
Output Coils
€ Output

B4 Move
[= SR hd

9¢

PLCStatusView

Processes gthercAT 36/*1%

Instance  Status Mapped SL
Main Running -
1ZoneAcc 0 Running E21,
Merge 0  Running E24, E25,

< >

O N A WN R

Menu Bar 9.

Project Explorer 10.
Ladder Library Window 11.
Ladder Editor 12.
Toolbox 13.
Cross Reference Window 14.
Debug Window 15.

Output Window

Conveyor Layout Window
Master Settings Window
Init Params Window
Device Editor Window

Device Network Browser

Connection Dialog

PLC Status Window

VSLogix’s user interface is split up into a series of windows and dialogues. VSLogix uses a Multiple
Document Interface (MDI), which means that many of the software’s windows can be opened at
once, and allows for features such as split view or opening documents as their own windows. Several
of the software’s key windows are shown in the above image. You may follow the above links to view
detailed descriptions of VSLogix’s many windows and capabilities.

© 2025 Vital

Systemes, Inc. 8

www.VitalSystem.com
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Menu Bar

| %, | @) prattorm . % . UEPE b # #h | Device Oniine | Moritoring Disab RAM(224/6144)|I
12 3 45 6 7 8 9 10 111213 1415 16 17 18
1. Create New Project 10. Ethercat Network Browser
2. Open Project 11. Download Current Project to Device
3. Save Project 12. Upload Project from Device
4. Find Window 13. Run All Ladder Programs on Device
5. Cross Reference Window 14. Stop All Ladder Programs on Device
6. Master Settings Window 15. Enable Monitoring
7. Select Platform 16. Device Connection State
8. Compile Ladders 17. Device Monitoring State
9. Connect To Device 18. Memory Consumption

The menu bar is located at the top of the screen and has buttons for various functions.

e 1-3 allow creating/opening/saving projects.

e 4 and5 are used to search through the ladder programs in the project.

e 6 opens the Master Settings Window for editing global settings.

e 7 is the Platform Selection. The Platform is used to select the intended device the project will
be running on. This updates the Ul to show the correct limitations and tooltips for the target
hardware. A Platform change will be prompted if the connected device does not match the
current project. You will be unable to download the project if there is a platform mismatch.

e 8 will compile the project for download.

e 9is used to connect a device to the VSLogix software.

e 10-15 require an active connection to be used.

e 16-17 display the state of the active connection.

e 18 displays the total memory used by the ladder programs on the device. If the maximum is
exceeded, you will not be allowed to download the project to the device.

© 2025 Vital Systemes, Inc. 9 www.VitalSystem.com
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Project Explorer Window

The Project Explorer Window is the basic navigation and Project Explorer o x
management window for the application. It is open by Yy =
default, but can be re-opened from the View Menu if closed. o v
- [=8 Master Settings
The Project Explorer displays: - Device List
e Current Active Project ~H Main Ladder
e Main Ladder Node — Editable Ladder program that is C—'J"'rrvé Conveyor Types (5/31)
always present in each project. H 1Zzone Accum
o Double click to open the Ladder Editor. ~H 2accum
o Right click to see options to start, stop, H 4 Aaccum
monitor the Main ladder and edit device map H
and parameters if an IntellECAT is connected H Merge
to VSlLogix. Conveyor Layout

-4l Conveyor Instances (7/31)
-2 1 Zone Accum 1
-2 2 Accum 1

e Master Settings Node — Opens Master Settings
window, allowing editing of global project settings.

e Conveyor Layout Node — Double clicking or Right
clicking then select Open Conveyor Layout will open
a Window that allows creation and configuring of ~E2
Conveyor Sections. -2 Merge 1

e Conveyor Types Node - Allows creation and
management of Conveyor Types. Double clicking this
node will open the Ladder Library Window.

o Right click on the Conveyor Types node gives
option to create new conveyor type, import
conveyor type from another project and view
ladder library.

o Displayed below are current Conveyor Types
in the project. Double clicking these nodes
will open the Ladder Editor.

o Dragging these nodes into the Conveyor
Layout Window will create a Conveyor
Section using that Conveyor Type.

© 2025 Vital Systemes, Inc. 10 www.VitalSystem.com
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Ladder Library Window

Project Library
Name Description Name Description
1ZoneAcc |1 Zone Accumulation 1ZoneAcc 1Zone Accumulation
2ZoneAcc |2 Zone Accumulation [ > | |8-Zone-Accum
4ZoneAcc Accum
Merge Standard Merge = " |3 Merge
mrg30
2 Zone Accumulation | Adding Test Description

Import Export Backups

The Ladder Library can be used to store ladder programs for use in later projects or retrieve ladder
programs from previous projects. It can be opened either by double or clicking the “Conveyor Types”
node, or from the tools menu. The Ladder Library will come with a set of example ladder programs in
installations of VSLogix. Below is a description of the available functions in the Ladder Library:

> Copies the selected Project Ladder into the Ladder Library
< Copies the selected Library Ladder into the Project
Import Import a Ladder into the Ladder Library from a Project (.vslgx), Ladder Library (.xml),
or Legacy Project (.Idr)
Export Export the Ladder Library to a Ladder Library file (.xml)

Backups The Ladder Library keeps the last 50 versions of itself in an Appdata folder. This
button opens the folder. Use the import feature to restore backups.
Right Click You can rename a ladder by right clicking it and renaming it. This may be necessary,
->Rename as duplicate names are not allowed
Right Click Deletes the selected ladders. You can delete multiple at once (use ctrl or shift click to

->Delete select multiple)

Select By selecting one of the description cells next to the ladder, you may edit its

Description | description. This is the same text that will appear at the top of the ladder editor.
Cell + Type

© 2025 Vital Systemes, Inc. 11 www.VitalSystem.com
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Ladder Editor

1 Zone Acoumulation Program

GBIN:1

OFF Delay Timer

System Start

XLE:UPIN
OFF Delay Timer

-

Zone 1 Photo Eye

Zone 1 Motor

Zone 1 Photo Eye

The Ladder Editor is where ladder programs are edited. This window can be accessed by Double-
Clicking either the Main Ladder, or a Conveyor Type node under “Conveyor Types” in the Project
Explorer. The window will also appear when you first create a new Conveyor Type by right clicking the
“Conveyor Types” node.

Ladder programs contain Rungs, which contain both Input and Output Ladder Commands. Input
Commands (Contacts) test conditions on data, while Output Commands (Coils) perform operations on
data. The data these commands operate on is specified by giving them a File Address.

© 2025 Vital Systemes, Inc. 12 www.VitalSystem.com
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By default, there are 5 Input Commands (Contacts) and 1 Output Command (Coil) per Rung. These
numbers can be increased by using Branches.

BIM:3

Among all branches on a rung, if there is at least one path in which all the Input Contacts’ conditions
are true, then all Output Coils on that rung will be executed. This behavior means that Input Contacts
in series will behave as a logical AND, while Input Contacts on parallel branches will behave as a
logical OR. For example, the above setup can logically be interpreted as (A && B) || (C && D).

Note that Ladder Programs and Rungs are executed sequentially. The highest rung in a ladder will be
executed first, followed by the second, and so on. The order of execution of Ladders Programs is as
such:

1. Main Ladder

2. Conveyor Sections, ordered first by Ladder Program, then by Name

Rungs, Branches, and Ladder Commands are inserted into the ladder program and subsequently
edited using the Toolbox Window. This window will automatically appear upon opening the Ladder
Editor.

Please refer to the File Type and Ladder Command sections for a full list and explanation of all the
available Commands and File Types.

At the top of the Ladder Editor, there is a RAM Usage counter. Some File Types (BIN, REG, FLT, and TC)
will consume Memory for each unique address used. The amount of memory consumed by a ladder is
shown at the top of the editor.

‘ ‘ RAM(2720/5144)

The Total Memory used by the Main Ladder and all Conveyor Sections cannot exceed the max
displayed at the top of VSLogix. If it does, you will not be able to download the project to the device. If
the value starts to approach the maximum, you may want to consider reducing the number of unique
addresses used in your ladders.

© 2025 Vital Systemes, Inc. 13 www.VitalSystem.com
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Below is a table listing useful input commands within the Ladder Editor.

Double Click a Ladder Double clicking any Ladder Command will bring up Quick Edit boxes to
Command change the File Address and Comment. Tab will switch between the
two. The Quick Edit Boxes will automatically appear when first placing
a Ladder Command.

CTRL+C/CTRL+V Rungs and Commands can freely be copy/pasted within and between
Ladder Programs

Hold CTRL when placing Holding CTRL when placing a Command, Branch, or Rung will allow you

Command, Branch, or to place multiple in a row.

Rung

Double Click Ladder Edit the Ladder Description at the top of the Ladder. This description is

Description, or Right Click | also listed in the LadderLibrary.
-> Ladder Description

© 2025 Vital Systemes, Inc. 14 www.VitalSystem.com
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Example Ladder

Using the above information of how the Ladder Editor works, we will create an example Ladder to
demonstrate the creation process. Let’s start by creating a simple flashing LED:

0 H A 1-0UT:1

e

System Timer Output LED 1

On the left we have a Normally Open command with the address CW:0.10, and on the right we have
an Output command with the address 1-OUT:1. A more detailed explanation of these addresses can
be found in the File Address section, but simply put:

e The Address CW:0.10 refers to the 10™ bit of Control Word 0, the System Timer. Since the
system timer counts up in milliseconds, the 10" bit will toggle every 2'° (aka 1024) milliseconds,
or roughly once a second. The Timer command exists for more complex timing needs.

e The Address 1-OUT:1 refers to digital output 1 of Device 1. Please refer to the Device File section
for an in-depth explanation of this syntax.

The Input command on the left will be active when the address it points to is true (in other words, a
one). Since there is only the one input command on the ladder, the Output on this Ladder, the LED,
will toggle roughly once a second.

CW:0.10 1-0UT:1

System Timer Qutput LED 1

BIN:O

Force On

Now, say we wanted to add an option to force the LED to always be on. We could accomplish this by
adding a branch parallel to the system timer contact. The output commands on a rung will be
activated so long as there is any one path from left to right whose conditions are true. With this
configuration, the state of the system timer contact doesn’t matter as long as BIN:0 is true. The
output will always be on. We could test this setup by manually toggling BIN:0 while Monitoring the

running program.

CW:0.10 1-0UT:1

System Timer Force Off Qutput LED 1

BIN:O

Force On
If we wanted to do the opposite and add a toggle to force the LED off, we could add a normally closed
contact in series with both branches. With this configuration, there can be no path from left to right
so long as BIN:1 is True.

© 2025 Vital Systemes, Inc. 15 www.VitalSystem.com
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Toolbox Window

The Toolbox window contains the needed tools and
actions for creating and editing ladder programs. From
this window you can add contacts, rungs, or branches,
and edit their various properties.

The Tool Box window will be opened automatically
whenever the Ladder Editor is opened.

The upper half of the toolbox window contains a list of
commands that can be inserted into a Ladder. Click on
the command, then select where to place it in the
Ladder Editor. You can place multiple commandsin a
row by holding CTRL when you place it. For a list and
explanation of how each of the commands works, see
Ladder Commands.

The bottom half of the Toolbox window contains a
property list of the currently selected contact, coil, or
rung in the Ladder. From here you can edit their various
properties. Some examples are the comment that
appears below that contact in the editor, or whether
the contact is enabled or not. The properties available
are dependent on the selected item.

© 2025 Vital Systemes, Inc. 16

Toolbox

Input Contacts

4 F NO Contact

¥ NC Contact

%7 Compare

Output Coils

- Output

f2f Move

28 Move Range

E Math

Timer /{Counter

RS Reset Timer/Counter
1 Send Message
Rung

Ic_b-/<\>] Insert Rung Above
I Insert Rung Below

= Insert Rung Branch

EL3

~ Command: Normally Open
Address

v Misc
Comment
Enabled

Comment

cw:0.8

True
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Cross Reference

Cross Reference

: Ladder Program: | [All Sources] || File Type _ALL v Refresh
File Type Files in Use o
GBIN 0,

TC_AC 0,123,

ALK 0,

1C 0,123,

IN 0,

ouT 0,

OUTEX 1,

cw 0,

BIN 0, M
Address Comment Location Ladder Program )
TC:2.T™M Tray Appr for Merge Zone  Rung:11, Position:2,... Merge

TC:2.T™ Tray Appr for Merge Zone  Rung:12, Position:2,... Merge

1C:3 Rung:7, Position:6, ... Merge

TC:3.AC Rung:6, Position:6, ... Merge

TC:3.DN Tray Approching forzon...  Rung:8, Position:1, ... Merge

TC:3. ™™ Tray Approching forzon...  Rung:6, Position:3, ... Merge

TCG:3. ™™ Tray Approching forzon...  Rung:7, Pesition:2, ...  Merge

TC:3. ™™ Tray Approching forzon...  Rung:S, Position:2, ... Merge

XLK:DNL.IN DOWNSTREAM CONTR...  Rung:4, Position:2, ...  1ZoneAcc

XLK:DN.IN mainline downstream is ... Rung:8, Position:2, ... Merge

XLK:DN.OUT TRAY EXITING CONTROL... Rung:6, Position:6, ... 1ZoneAcc

XLK:DN.OUT Tray Exiting Controller Rung:1, Position:6, ... Merge

XLK:LF.IN Tray Approaching from ... Rung:10, Position:1,... Merge NG
< >

The Cross Reference View provides a list of which Device Files are used in the current project. It also

lists which rung and Ladder Program is referencing the file. You can jump directly to that usage by

double clicking it.

Debug Window
Debug

Diescription
[IM:1]

R

IM requires a scope prefix, |[E: O-IM:0

File
47onebcc

Rung Position

3 1

Level

1

B Output |4 Debug

© 2025 Vital Systemes, Inc.
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The Debug Window displays compilation errors for the ladder program (if there are any) after the
compilation process. Error entries can be clicked to jump to the source of the error. The Debug
Window can be accessed by clicking the Debug Window Icon under the menu bar, otherwise it pops-
up when errors are detected after compiling a Ladder Program.

Output Window
Output

Description

Connected to: 192.168.1.91
Connected to: 192.168.1.91

Build Started (9/10/2024 2:02:01 PM) ...
ERROR [IN:1] IN requires a scope prefix, IE: 0-IN:0
Build Error.
Time: 78.8937
E] Output J‘ Debug |
The Output Window provides detailed and technical feedback such as application log messages,
compile messages, and errors. The Output Window can be accessed by clicking the Output Window
Icon under the menu bar, otherwise it pops-up automatically when necessary.

Conveyor Layout Window

LF
Accum0 Mergel Accum?2 Accum4
DN————>»UP DN——»UP DN———»UP DN————>»UP

© 2025 Vital Systemes, Inc. 18 www.VitalSystem.com
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The Conveyor Layout window is opened by double clicking the corresponding node in the Project
Explorer window. This window is used to create and arrange Conveyor Sections in a graphical view.
You can create a Conveyor Section by dragging the desired Conveyor Type from the Project Explorer
into the Conveyor Layout window.

1ZoneAcc
! s Drag

E 4Zonehcc \
E Merge

@ Conveyor Layout

..... @ Conveyor Instances (0/31)

Alternatively, you can create a section by right clicking into a blank area on the grid:

Add Remote Device (2/4)
Create Section
MyConveyorsection

After creating more than one section, you can create interlocks between them. These allow the
Ladder Sections to pass data directly to one another. To do this, first select one section, then press a
key to choose a port. Then select a different section you want to connect it to, and press a key to
choose its port.

The available port choices are:

u Upstream

D Downstream
L Left

R Right

0-9 Auxiliary 0-9

Note the direction of the arrows. Arrows will point away from Downstream ports and towards
Upstream ports to signify the flow of packages.

Accum?2

© 2025 Vital Systemes, Inc. 19 www.VitalSystem.com
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Note that interlocks simply allow the transfer of data from one section to another. It is up to the
designer of the ladder program to choose what data to send, and how to process it. Within the Ladder
Program, this Interlock data is accessed using the XLK Filetype.

¥LK:DN.OUT MLK:UP.IN

Send Package Ready

You can also right click the Conveyor Sections to edit their Device Maps, to edit their Initial
Parameters, or to delete them. You can also select monitor, or double click the section to open its
monitoring window. Note that Monitoring the section’s execution in real-time will require an active
connection to the IntellECAT gateway.

When you monitor a conveyor section, Monitoring Mode will be activated. This will be indicated at
the top of the screen. You can also manually enable or disable Monitoring Mode with the binoculars
button. While Monitoring Mode is enabled, the Conveyor Layout window will display very basic
information about the Conveyor Sections. The left Green LED will display whether the Section is
currently running. The right orange LED will blink whenever one of the Section’s outputs changes a
value. Note that you cannot edit anything in the Conveyor Layout window while Monitoring mode is
enabled.

N
Up

XlkkTestD

In addition to adding Conveyor Instances, you can also create Remote Devices in the Conveyor layout
Window. These appear similar to Conveyor Sections, with some key differences:

Add Remote Device (2/4)
Create Section
MyConveyorsection

© 2025 Vital Systemes, Inc. 20 www.VitalSystem.com
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There are two types of Remote Devices that can be created, 3G and IntellECAT.

3G/OCTO IntellECAT

3G Remote Device

By adding a 3G remote device, the IntellECAT card can communicate with an existing Smart3G/OCTO
network through interlocks as if it were a 3G/OCTO card itself. This allows Smart3G and IntellECAT
networks to coexist and interop together.

IntellECAT Remote Device

By adding an IntellECAT remote device, the network of Conveyor Sections in the current IntellECAT
Project can be connected seamlessly with those in another IntellECAT. Interlocks are made with the
Remote Device both on the sending and receiving side as if the Remote Device were just another
conveyor Section.

The primary difference between these two is that 3G Remote Devices only support 1 interlock at a
time, and do not support interlock messaging. IntellECAT Remote Devices support up to 14 Interlocks
and do support interlock messaging.

Project Settings Window

1® Project Settings — O x

. Global InitParams

Operation

] Gateway Made Target Device: | Intellecat w

The Project Settings window is used to configure global settings for the device. This includes:
e Toggling Gateway Mode Gateway Mode on or off
e Selecting the target hardware the project is intended for
e Setting Global Init Parameters, effectively default values for global files

© 2025 Vital Systemes, Inc. 21 www.VitalSystem.com
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Init Params Editor

85 Parameters : Accum0 — O >

Address Value Comment

(3]

The Initialization Parameters Editor (Init Params for short) allows you to set the values for files on
startup of the device. These values will be set whenever a ladder is first started. Simply enter the file
address into the address cell and the desired value into the value cell. Rows can be deleted by
selecting the row’s header cell and pressing the delete key.

There are two different Init Param editors available:

e One specifically for Global File Types, accessible from the Project Settings Window. There is a
limit of 30 Global Init Params.

e One for Local File Types, accessible by right clicking any Conveyor Section. There is a limit of 10
Init Params for each Section.

Device Editor

You can open this window from the Tools dropdown on the menu bar, by right clicking a Conveyor
Section and clicking “Edit Device Map” or from the GX20 Status Tab. This window is used to configure

the devices in your project, and will be used in every project. Refer to the Device File section to see
how Devices should be accessed within ladder programs.

© 2025 Vital Systemes, Inc. 22 www.VitalSystem.com



http://www.vitalsystem.com/

= sy};nj’éi% EtherCAT. IntelleCAT PLC/Gateway

Device Profiles Tab

o® Device Editor _ o %
EtherCAT 3G/OCTO Devices Device Profiles (7
Mame Model Settings

Tag Text Type Index Attribute

M1 ouT 0 MNone

MOT1 ouT 0 None

MTR2 ouT 1 None

M2 ouT 1 MNone

MOT2 ouT 1 None

DIR ouT 2 None

IN1 1IN 0 MNone

51 IN 0 None

IN2 IN 1 None

52 1IN 1 MNone

FAULT1 IN 2 None

FAULT2 IN 3 None

SPEED OUTEX 1

SPEEM QUTEX 1

SPEED2 OUTEX 2

QK Cancel

In the Device Profiles tab, you can see profiles for device models. Currently, this is used to find the
acceptable Tag Text for different type of I/O and their respective index values of GX20 Control cards.

When using a Device File, you can use any of the listed tags instead of needing to manually determine
the proper Index and Attribute. For example, | can turn on Motor 1 on a GX20 card like so:

1-MTR1

© 2025 Vital Systemes, Inc. 23 www.VitalSystem.com
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EtherCAT Tab
¥ Device Editor = O X
EtherCAT 3G/0CTO Devices Device Profiles @
Device Report [_] Hide Unmapped Devices Clear All
Profile Description
1 GX20 ~ | Accum 1 Card Clear
2 GX20 | Accum 2 Card Clear
3 GX20 ~ |Merge 1 Card Clear
4 GX20 ~ |Merge 2 Card Clear
5 GX20 | Transfer Card Clear
6 G20 | Not Used Clear
7 GX20 | Mot Used Clear
8 i Clear
] v Clear
10 = Clear
1 v Clear
12 = Clear
13 A Clear
14 = Clear
15 i Clear
16 i Clear
17 i Clear
18 i Clear
oK Cancel

The EtherCAT tab allows you to configure which GX20 control cards will do data exchange with the
IntellECAT. Any device that has a profile selected will be searched for by the IntellECAT, and will
perform data exchange if it is found. The profile should match the type of GX20 control card you

intend to connect to. On the left of the tab, you can see the device IDs.

For example in the above image we have set ID 1-7 to GX20, so communication will be performed
with these cards on the network. If a configured device is not found on the network, it will still be

scanned for and communication will begin when it is found.

© 2025 Vital Systemes, Inc. 24
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Device Map Tab

1® Device Editor - Transfer - 1 - O *
DeviceMap  EtherCAT 3G/OCTO Devices Device Profiles (7
Device
b Device-1 GX20-1 bt
Device-2 GX20-12 o
Device-3 GX20-15 o
oK Cancel

The Device Map tab can be opened by right clicking a conveyor section and selecting “Edit Device
Map.” This can be done from either the Project Explorer or the Conveyor Layout window. Within the
window Device Placeholders will appear in the left column. In the right column you can map to these
placeholder devices that were configured in either the EtherCAT or 3G/OCTO tabs.

This functionality exists so that Ladder programs can be written once and be reused multiple times in
the same network, for different sets of GX20s. For example, | may create an accumulation Conveyor
Type that controls the motors of a GX20 card. From this Conveyor Type | could create two Conveyor
Sections and map two different GX20s to these sections.

Refer to the Device File section to see how Devices should be accessed within ladder programs.

EtherCAT Network Browser
¥ ECAT Metwork Browser — O e

Address

Scan ECAT Network ‘ |SlaveList | | Profile |

The EtherCAT Network Browser can only be accessed after an IntellECAT gateway is connected to

VSLogix via the Connection Dialogue. The EtherCAT network will be scanned and all devices on the
network will be displayed in this list. Displayed will be the address of the device, the Model of the

device, and finally the profile for that device (GX20).

© 2025 Vital Systemes, Inc. 25 www.VitalSystem.com
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Connection Dialogue

0 -0 -0 - 0 Manual Connect
Metwork Map

192168521 192.168.0.10 15216804 |+
Intellecat 51

Auto-Assign |P Scan Connect

Cancel

Although VSLogix can compile Ladder-Logic programs, running them requires a connection to a
compatible device (IntellECAT).

Click the Connect Button to make the Connection Dialogue appear. The connection dialogue will scan
all available network adapters and create a list of all detected devices. You can either double click, or
select the device and click Connect to connect to a device. If the desired device is not listed after the
scan, you can attempt to connect manually by typing the desired IP into the IP box, and clicking
Manual Connect.

Auto-Assign IP will command all compatible devices on the network to change their IP Address to
match the network they’re on. It is a good idea to attempt this if the device fails to appear when
scanning. However, we would advise against performing auto-assign on production networks as
resetting all device IPs could cause issues on complex network configurations.

NOTE: Before attempting a connection, make sure that the device is connected to the network and
is not in an error state (such as conflicting IP Address).

© 2025 Vital Systemes, Inc. 26 www.VitalSystem.com
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Device Status Window

The Status Window is open by default, but can be accessed from the View menu at the top of the
screen if it is closed. The Status window displays information about the connected device, as well as
its files. At the top of the window is generic information about the device, such as its IP address and
the name of the loaded project. The bottom of the window is split into 5 Tabs:

N ~x Processes

This tab displays all the conveyor sections in the project
currently loaded on the device, as well as their Status
(whether they’re currently running or not), and the
devices mapped to that section. You may start or stop an
individual section, or monitor its execution by right
clicking it. At the right of the tab are all the Ladder

Processes |EtherCAT | 36/0CT0 | CB/CW | GBIN/AREG Programs in the project, as well as their checksums.
Instance Status Mapped Slaves Ladder . . . . . . .
i T ST Finally, in the far right column is listed the execution time
Lzonedce 0 Rumning  E21, 1zeneice / EFSDC in microseconds each section is taking during runtime.
1Zonehkcc 1 Running E22, 1ZoneRecc f EFSDC

1Zonehcc 2 Bunning E23, 1ZoneRcc / EFSDC

lZonesfcc 3 Running E24, l1Zonelcc / EFSDC

lZonehcc 4 Bunning E25, 1Zonelcc / EFSDC

lZIonekcc 5 Running E2g, l1Zonelcc / EF9DC

© 2025 Vital Systemes, Inc. 27 www.VitalSystem.com
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Processes EtherCAT 36/0CT¢ (B/CW GBIN/GREG

Master Status

op Safe-Op Pre-Op Init
@ @ ® ®
Edit Device List Browse Network

2L
ONLINE

GXel

2c

ONLINE

GXel

© 2025 Vital Systemes, Inc.

EtherCAT

The GX20 tab displays the GX20 status of the IntellECAT
master, as well as the status and 10 of all the
configured devices in the connected device’s Device
List. You can witness the status and 10 change in real
time, and can manually toggle the |0 yourself either by
clicking the desired Output, or by creating a Device
Override by right clicking the device. Creating a Device
Override will allow you to override the output
regardless of the program’s execution.

From this tab you may also open the Device Editor for
the current project by clicking Edit Device List, or open
the ECAT Network Browser by clicking Browse Network.

Here is a description of each of the Master Status bits:

28

OP — In this state, full process data exchange is
possible between the master and it’s connected
devices. Both inputs and outputs are active, and
the system is fully functional. This is the state in
which normal EtherCAT communication and
control occur.

Safe-Op — The device is ready to exchange
process data but will not affect its outputs (they
are in a safe state, typically off or held). Inputs
can be read, but the outputs are disabled for
safety reasons. This state is used to ensure that
inputs are valid before switching to the fully
operational state.

Pre-Op — In this state, the device is partially
operational. It can communicate with the
master but cannot yet exchange process data.
Configuration parameters and initialization
commands can be exchanged between the
master and the device. This is where the master
configures the connected devices.

Init — This is the starting state after the device
powers up or gets reset. In this state, the device
is initializing its hardware and software. No
communication with the master occurs in this
state, and no process data exchange is possible.

www.VitalSystem.com
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Processes EtherCAT 36/0CTC¢ (B/CW GBIN/GREG

OUTPUTS

INPUTS

OUTPUTS

INPUTS

OUTPUTS

INPUTS

OUTPUTS

INPUTS

OUTPUTS

INPUTS

NET

IGPUR

NET

IOPUR

NET

IOPUR

NET

IOPUR

* (lick an LED or enter new value in
Register Grid during monitoring

6lobal Bins

Processes EtherCAT 36/0CT¢ CBs/CW GBIN/GREG

© 2025 Vital Systemes, Inc.

3G/0CTO

The 3G/OCTO tab allows you to view the Status and 10
of the connected Smart3G and OCTO cards, which were
configured from the Device Editor. Similar to the GX20
tab, you may toggle the Device’s 10 by left clicking the
desired |0, or by creating an override by right clicking
it.

Here devices with ID 80 - 84 are displayed in the status
window, which means, these devices have been used in
the ladder program. The device with ID80 is connected
to the IntellECAT as we can see the NET and IOPWR
lights are on.

CB/CW and GBIN/GREG

Both the CB/CW and GBIN/GREG window work in the
same way. They simply allow you to view the specified
files update in real-time on the connected device. You
can toggle the Boolean values by clicking them, or edit
the integer values by clicking them, entering a new
value, and pressing enter. Hovering over either a
Control Bit or Control Word cell will display a tooltip for
that cell’s function.
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V. Workflow

1. Creating Ladder

In the Project Explorer, either open the Main Ladder by double clicking the Main Ladder node, or
create a Conveyor Type by right clicking the Conveyor Types node. The Ladder Editor will be opened
and you may begin editing the Ladder. Refer to the section on the Ladder Editor as well as the
sections on FileTypes and Ladder Commands for instructions on how to design ladder programs.

Specifically, make note of how to use Device FileTypes in the Device Files section. This will be
necessary for any VSLogix project.

Example Ladders are available on new installations in the Ladder Library.

2. Configuring DevicelList

Open the Device Editor from the Tools menu. On the EtherCAT tab, select the devices you are using in
their respective addresses. For example, if you are using GX20 control card which has ID 22, select
profile 22 and assign GX20 control card there. Selecting a matching profile for a device will add it to
the IntellECAT’s data exchange scan list.

In the Device Profiles tab, you can see the name of the devices and when you select a device, you can
select the tag text, type and index applicable to that device.

3. Creating Conveyor Sections
This step is only necessary if using Conveyor Types and Conveyor Sections. If only using the Main
Ladder, this step can be skipped.

You can right click on Conveyor Types node and create new ladder program and design your ladder
program in the ladder editor. Under Conveyor Types node, you can create 31 different conveyor
types. These conveyor types can be template of conveyor sections that are repeated in your conveyor
project. For example, if your entire conveyor project requires, 3 similar merge sections, you can
create one merge template under Conveyor Type node. You can then use this merge template in
Conveyor Layout window and create three merge sections by placing it in the correct location in the
Conveyor Layout.

To use the templates of conveyor types, open the Conveyor Layout window by double clicking the
Conveyor Layout node and drag Conveyor Types from the project explorer into the window to create
Conveyor Sections. There are 3 things you can now do to configure these conveyor sections:

Right Click -> | This will open the Device Editor with an extra tab for the Section’s Device map.
Edit Device map | Any Device Placeholders in the ladder program will appear here in order to be
mapped to an GX20 or VSI device that was configured in the Device Editor.

Right Click -> | This will open the Init Param Editor. This allows you to set the default starting
Edit Init Params | value of local filetypes within that section.

Create Interlocks can be created between sections to allow passing data between them.
Interlocks The specifics of how to do this are outlined in the Conveyor Layout section.

© 2025 Vital Systemes, Inc. 30 www.VitalSystem.com
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You can rename any conveyor section by Right Click > rename option. You can quickly go to the ladder
editor of any conveyor section by Right Click > Edit Ladder. You can also run, monitor or delete any
specific conveyor section by Right Click and selecting Run Ladder, Monitor or Delete respectively.

4. Going Online
After connecting to the device via the Connection Dialogue, the Status window will automatically
begin to monitor the state of the device. You will be able to see the |0 of the GX20 control cards and
the Global Files update in real time. Several buttons on the Menu Bar will also now be selectable:
o 4iDownload — Installs the current project to the device. When a device has a project downloaded
in it, it will always run the ladder programs on power-up, or when toggled by the user in VSLogix.

. *E‘:’Ugload — Retrieve the project from the device and open it in VSLogix. You can do this to connect
to any given device and quickly edit its loaded project, or to monitor the running ladder programs
in action (a matching project is required to be opened in order to monitor the ladder programs
running on the device.)

o ORun - Enables the execution of all Conveyor Sections on the device. Sections can also be Run
individually by right clicking them and selecting the Run Ladder option from the pop-up menu.

° C’Stog — Disables the execution of all Conveyor Sections on the device. Sections can also be
Stopped individually by right clicking them and selecting the Stop Ladder option from the pop-up
menu.

o #Monitor - Toggles monitoring mode. While in Monitoring mode, you will be able to see the
execution of the Conveyor Sections’ ladder programs in real time. Simply double click any Conveyor
Section, or right click and click ‘Monitor’ to open the Monitoring window for that Section. While in
Monitoring mode you will be unable to edit the ladder programs. Clicking the Monitor button while
the project on the device does not match the one loaded in VSLogix will download the project to
the device, then enable monitoring mode.

Once online, you will also now be able to open the EtherCAT network browser from the EtherCAT tab
of the Status window. This will allow you to view all GX20 control cards on the EtherCAT network,
whether they have been configured in the project or not.
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V. Files Addresses

IntellECAT Ladder programs use Ladder Commands to operate on addressable Files that store data.
The address format for these files follows this basic syntax:

Scope-Type:Index.Attribute

Note that scope and attribute may not be used with all filetypes. Here are a few example usages of
files within a ladder:

BIN:0

This will write a

Refer to the Ladder Editor section for more info on the basics of how the Ladder Programs operate.
Refer to the Ladder Command sections for a list of all available commands usable in the ladder
program.

File Types are split into 3 categories:
e Local Files — These files are local to the Ladder Program in which they are used
o BIN —Boolean value (0 or 1)
o REG —Signed 32-bit Integer
o FLT —Signed 32-bit Float (floating point value)
o TC-Timer/Counter
o XLK —Interlock between sections
e Device Files — Requires Scope to identify the device being accessed
o IN - Digital Input on specified Device
o OUT - Digital Output on specified Device
o INEX —Extended Input
o OUTEX — Extended Output
e Global Files — Shared across all Ladder Programs
o CB-Control Bit (O or 1)
o CW —Control Words (Signed 32-bit Integer)
o GBIN — Global Boolean value (0 or 1)
o GREG - Global Signed 32-bit Integer

File Index limitations depend on the category of the File Type:

e Local Files each take up a certain amount of memory. As long as you stay under the total RAM limit,
you can use as many of each Type as you want. The exception is the XLK file, of which only 8
interlocks are allowed.

e Both Device and Global Files have set limitations for each file type. For example, there are only 32
Control Bits. Indexes above this cannot be accessed as they do not exist.
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Below is a more detailed explanation for each of these files.

Legend:
Description | General Information and notes on the file type.
Keyword The keyword syntax used to reference the file.
Scope Defines the rules about where and how the file can be accessed. Has a value of either
Local, Device, or Global.
The data attributes that are present for the given filetype. The data type of the
attribute will be enclosed in parentheses (Booelan, Integer, Float).
The individual bits of all filetypes can be accessed by supplying a number for the
Attributes | attribute. For example, an attribute of 3 will access bit 3 of that file.
Some filetypes also allow a syntax to read/write multiple bits at once. An attribute
with the format ‘b0000’ will specify a bitmask in binary with the bits you wish to
read/write. Hexadecimal can also be used with the format ‘h00’. FileTypes where
bitmask reading/writing are allowed will have this specified in their attribute section.
Format The Format address syntax used to reference a specific file in the Ladder Program.
Usage How the file can be used (Read, Write, or both).

Local File Types

Local Files are local to each running ladder program. The Main Ladder as well all Conveyor Sections
have their own copies of every local file they contain.

e BIN —Boolean value (0 or 1)

e REG -Signed 32-bit Integer

e FLT —Signed 32-bit Float (floating point value)
e TC-Timer/Counter

W

° LK — Interlock between sections

The types BIN, REG, and FLT will automatically allocate memory as you use them in your program. The
TC type requires the use of a TC Ladder Command for each unique index used in the program. The XLK
type is hard limited to 8 indexes per program.
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Binary Files

Description | A pit value that can be 0 or 1.

Keywo rd BIN

Scope Local

Data Type | Boolean

Usable e None

Attributes | ¢ Full — Directly access the BIN’s containing integer (becomes Integer type)
Format BIN:<file index>.<optional attribute>

Usage Read, Write

Register Files
RE&:0.10

A 32-bit signed integer. Referred to plainly as “Register” in VSLogix.

NOTE: Although numerical values with decimal point precision can be assigned
to these files, the digits following the decimal point are dropped. For numerical
values with a decimal point, consider using the float registers (FLT).

Description

Keyword REG

Scope Local

Data Type | 32-bit Signed Integer

Usable e None
Attributes | ¢ Bit Indexing [0 —31] (becomes Boolean type)

Format REG:<file index>.<bit index>

Usage Read, Write
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Float Files

Description A 32-bit signed floating-point value that can use fractional values following a decimal
point.

Keywo rd FLT

Scope Local

Data Type | 32-bit Floating Point

Usable N

Attributes * one

Format FLT:<file index>

Usage Read, Write
Timer Files

0N Delay Timer

ID 0

Preset 2000

Timers that can keep time in a resolution of milliseconds. The timer keeps time until the
user-defined preset value is reached.

Unlike other FileTypes, each Timer/Counter File corresponds to an associated
Timer/Counter command in the Ladder program. You cannot use a Timer/Counter file
index if there is not a Command with that ID.

Description

The Filetype TC is used for both Timers and Counters. Whether it is a Timer or Counter
can be configured at the Timer/Counter command.

Keyword TC

Scope Local

Data Type | 32-Bit Signed Integer / Boolean
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e None/AC — Accumulated Time in milliseconds (int value).
e PR - Preset Value in milliseconds (int value).

Usable ,

. e EN —Timer Enabled (bool value).

Attributes
e DN —Done Timing (bool value).
e TM — Currently Timing (bool value).

Format TC:<file index>.<attribute>

Usage Read, Write (PR Only)

Counter Files

UP Counter
D 1

Preset 300 ﬁ
Accum 0 . RESET TC:1 .

Counters that increment their accumulated value by 1 every time the rung state
transitions to true. Directly usable only with the Reset and Counter Command.

. Unlike other FileTypes, each Timer/Counter File corresponds to an associated
Description | Timer/Counter command in the Ladder program. You cannot use a Timer/Counter file
index if there is not a Command with that ID.

The Filetype TC is used for both Timers and Counters. Whether it is a Timer or Counter
can be configured at the Timer/Counter command.

Keyword TC

Scope Local

Data Type | 32-Bit Signed Integer / Boolean

e None/AC — Accumulated Counts (int value).
Usable e PR —Preset Value (int value).
Attributes e EN — Timer Enabled (bool value).

e DN — Done Timing (bool value).

Format TC:<file index>.<attribute>

Usage Read, Write (PR Only)

© 2025 Vital Systemes, Inc. 36 www.VitalSystem.com



http://www.vitalsystem.com/

m TAL EtherCAT — IntelleCAT PLC/Gateway

:Systems inc

Interlock Files

¥LE:DN.OUT

Send Package Ready

¥LEGUP.IN

Receive Package
Ready

Used to send or receive data between two connected Conveyor Sections. In place of

Descriptio | using a number for the File Index, you can use one of the below Interlock Keywords to
n choose the Interlock to access: UP, DN, LF, RT, AO, Al, A2, A3, A4, A5, A6, A7, A8, or A9.
Use of one of the Attributes IN, OUT, IMSG, IMSG1 or IMSG2 is required.
Keyword XLK
Scope Local
Data Type | Boolean, Integer
e [N — Read bit coming from the connected Section (bool value)
e OUT — Read/Write bit going to the connected Section (bool value)
Usable e IMSG — This bit is set to true when a message is received from another Conveyor
Attributes Section using the SendMessage command (bool value)
o IMSG1 — The first integer file received from a SendMessage Command (int value)
e IMSG2 - The second Integer file received from a SendMessage Command (int value)
Format XLK:<interlock channel>.<attribute>
Usage Read, Write (OUT, IMSG only)
In the below diagram, Section1 has a Downstream Interlock Output, while Section2 has
an Upstream Interlock Input. Since Sectionl’s downstream is connected to Section2’s
Example upstream in the Conveyorlayout window, Section2’s output will be activated when

Sectionl’s input is activated.
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Section 1

Section 2

Serdon 1 Section 2

¥LK:DN.OUT XLK:UP.IN 1-0UT:1

Ib Device-1 GX20-1 |> Device-1 GX20-2

In this example, the XLK Sender Section is using the SendMessage command to send a
message to the XLK Receiver Section.

XLK Sender XLK
— Receiver

MyConveyo MyConveyo

¥LE:LF.IMSG

¥LE:LF.IMSG

U y—

The XLK Receiver is checking the IMSG bit to look for a received message. Once it finds it,
it uses Move commands to copy over the message data from the IMSG1 and IMSG2
attributes. Then it unlatches the IMSG bit to indicate the message has been processed.
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Device File Types
Usage of these File Types requires a prefix that specifies which Device the File belongs to. The format
goes like this:

Device-Keyword:Index

So for example:

E1-M1

This would access Motor 1 of EtherCAT Device 1.

There are two ways to address a device, Absolute and Placeholder:

Absolute The scope of each device File must start with a prefix:
E#, e E — EtherCAT Device

3GH, e 3G, OCTO, V — 3G or OCTO Device

OCTO#, V#

Using the prefix followed by a number will refer directly to that device address. E10 will
refer to the EtherCAT Device (GX20) with address 10. If you use V10/3G10/0CTO10, it
will refer to a Vital Systems device (Smart3G/OCTO) with that address.

Placeholder | If you instead wrap the number in parentheses, the address will be a Placeholder

E(#), Address. As the name suggests, placeholder addresses do not directly refer to the
3G(#), device to be controlled, but will later be mapped to the desired device using the Device
OCTO(#), Mapping window.

V(#)

This is usually preferred over Absolute addresses as it allows you to reuse a conveyor
type multiple times, mapped to a different set of Devices each time. Even if no reuse is
desired, it still allows you to easily change the mapped device without needing to edit
the ladder itself.

For example, | might use the File Address E(1)-IN:1 in my Conveyor Type. Later | create
two Conveyor Sections from this Type. In the DeviceMap Window on one section, |
could map the Placeholder 1 to GX20 with address 5, while in the other | could map it
to a GX20 with address 7.

Refer to the Profile tab of the Device Editor for an explanation of Short Tags such as M1, S1, MOT1, etc.
that will help you write more readable ladder programs.

Device Files:

e |IN — Digital Input on specified Device
OUT - Digital Output on specified Device
INEX — Extended Input

e OUTEX — Extended Output
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Inputs

Photo Eye 1

Description | |5yt state of the selected device (similar to BIN values in usage).

Keyword IN

Scope Device

Data Type | goolean

Usable e None
Attributes | ¢ Full - Directly access the File’s containing Byte (becomes Byte type)

Format <device>-IN:<fileIndex>

Usage Read

In the below diagram from the Interlock page, we can see that the Section on the left is
going to set an Interlock output (Package Ready) when the Input is triggered (for
example, a Photo-Eye input that will detect the presence of a box). In the Device Map
window for Section1, Device-1 has been mapped to GX20-1. Therefore, 1-IN:1 will
correspond to Input 1 of GX20 control card 1.

Example Section 1 Section 2

Serdon 1 Section 2

XLK:DN.OUT XLK:UPIN 1-0UT:1

Send Package Ready

I b Device-1 GX20-1
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Outputs

1-0UT:1

Conveyor Motor

Description Output state of the selected device(similar to BIN values in usage).

Keyword ouT

Scope Device

Data Type | goolean

Usable e None
Attributes | ¢ Full - Directly access the File’s containing Byte (becomes Byte type)

Format <device>-OUT:<file index>

Usage Read, Write

In the below diagram from the Interlock page, we can see that the Section on the right is
going to turn on a motor when the Output is activated (in this example, when there is a
box present in the previous section.) In the Device Map window for Section2, Device-1
has been mapped to GX20-2. Therefore, 1-OUT:1 will correspond to Output 1 of GX20
Control card 2.

Section 1 Section 2

Example

Serdon 1 Section 2

XLK:DN.OUT XLE:UPIN 1-0UT:1

IP Device-1 GX20-1 ID Device-1 GX20-2
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Extended Inputs

B(1)}-INEX:0.0

Photo Eye 1

Description | |5yt object available to the Device
Keyword INEX
Scope Device
Data Type | 3Bt Signed Integer / Boolean
Usable e None
Attributes | ¢ Bit Indexing [0 —31] (becomes Boolean type)
Format <device>-INEX:<file index>.<attribute>
Usage Read
Some Devices may have more data available to them past the standard inputs. The INEX
filetype allows you to read from the full range of outputs available to the device. For
example, here are the extended outputs for the GX20:
Address | Name Notes
INEX:0 Sensors/Motor This is also the data written to when using IN:
Faults Bit 0 Sensor 1
Bit 1 Sensor 2
Bit 2 Motor Fault 1
Example Bit 3 Motor Fault 2

INEX:1 Motorl Current Current value of Motorl in mA
INEX:2 Motor2 Current Current value of Motor2 in mA

INEX:3 Power Voltage Input voltage on the GX20 card from power supply

INEX:4 Motorl Peak Highest current seen on the Motor1 output
Current

INEX:5 Motor2 Peak Highest current seen on the Motor2 output
Current

As mentioned in the Device Profiles section, it may be recommended to use the short
address tags available for devices instead of directly using the INEX syntax.
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Extended Outputs

E{1)-0UTEX:0.0

Motor 1 Enable

Description | oytput object available to the Device

Keyword OUTEX

Scope Device

Data Type | 3Bt Signed Integer / Boolean

Format <device>-OUTEX:<file index>.<attribute>

e None (becomes Integer type)
e Bit Indexing [0 —31] (becomes Boolean type)
o Example: E(2)-OUTEX:0.5 will access the 5% bit of Extended Output 0, on
EtherCAT device 2

Usable e Bit Mask [b0000, or h00] (becomes Boolean type. Read/Write multiple bits at once)

Attributes o Example: E(3)-OUTEX:1.b1010 or E(3)-OUTEX:1.hOA will write to the 2" and
4™ bits of Extended Output 1, on EtherCAT device 3

o Note: Using this syntax on an Output Command will write to all specified bits.
Using this syntax on an Input Command will perform an OR between all
specified bits.

Usage Read, Write

Some Devices may have more data available to them past the standard outputs. The
OUTEX filetype allows you to write to the full range of outputs available to the device.
For example, here are the extended outputs for the GX20:

Address | Name Notes
OUTEX:0 | Motor This is also the data written to when using OUT:
Outputs/Direction || Bit0 Motor 1 Enable
Example Bit1 | Motor 2 Enable

Bit 2 Motorl Direction
Bit 3 Motor2 Direction
OUTEX:1 | Motor Speed 1 Value from 0-100 defining speed of Motorl
OUTEX:2 | Motor Speed 2 Value from 0-100 defining speed of Motor2

As mentioned in the Device Profiles section, it may be recommended to use the short
address tags available for devices instead of directly using the OUTEX syntax.
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Global File Types
These files are shared among all different running ladder programs. They can be assigned a default value
on startup using the Init Params tab in the Master Settings Window.

e (B - Control Bit (Boolean type with pre-defined function)

e CW - Control Words (Signed 32-bit Integer with pre-defined function)
e GBIN — Global Boolean value

o GREG — Global Signed 32-bit Integer

Control Words

CW:0.10

System Timer

Description Special purpose 32-bit signed integers for device control. Each one has a unique
predefined function.

Keyword CcW

Scope Global

DataType | 37.Bit Signed Integer

Usable e None

Attributes | ¢ Bit Indexing [0 —31] (Becomes Boolean type)

Format CW:<file index>.<attribute>
CW | Usage | Description
0 R System Millisecond Timer. Counts up from 0 starting when
entering run mode
Usage 20 R/W | Send Message Address (1-250)
22- R/W | Send Message Data
29
30 R Receive Message Address (1-250)
31 R Receive Message Type (Smart3G : 67, IntellECAT : 80)
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32- R Receive Message Data

39

40- R Data from Ethernet/IP Master (Refer to Protocols section)
49

50- R/W | Data to Ethernet/IP Master (Refer to Protocols section)
59

*Unmentioned CW indexes are currently reserved

Example The example is using a Normally Open command with the 10" bit of CW:0, aka the
System Timer. This setup will toggle state once every 2210 (1024) milliseconds.

Control Bits

Description | special purpose boolean values for device control. Each one has a predefined function.

Keyword CB

Scope Global

DataType | goolean

Usable e None
Attributes | ¢ Full - Directly access the File’s containing Integer (becomes Integer type)

Format CB:<file index>

CB Usage | Description
Usage 10 R/W Message Received Bit. Left to the user to clear it.

*Unmentioned CB indexes are currently reserved

Global Binary Files
GBIN:0

User-Defined
Global Boolean
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Description | A global bit value that can be 0 or 1. The IntellECAT has a maximum limit of 24 GBINs at
once.

Keyword GBIN
Scope Global
Data Type | Boolean
Usable e None
Attributes | ¢ Full - Directly access the File’s containing Integer (becomes Integer type)
Format GBIN:<file index>
Usage Read, Write

Global Register Files

GREG:0

Description | A giobal 32-bit signed integer. The IntellECAT has a maximum limit of 20 GREGs at once.
Keyword GREG

Scope Global

Data Type | 32-Bit Signed Integer

Usable e None

Attributes | ¢ Bit Indexing [0 —31] (Becomes Boolean type)

Format GREG:<file index>.<bit index>

Usage Read, Write

VI. Ladder Commands
A Ladder Program is comprised of multiple rungs that are executed continuously from top to bottom.
Each rung is comprised of two types of commands: inputs and outputs.

Input commands are used to determine the state of the rung: active or inactive. The state of the rung
decides whether to execute that rung’s output commands.

Output commands are commands that carry out actions in the ladder program such as writing to file
values. The exact triggering behavior of the output depends on the specific command used: some will
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perform an action on switching from inactive to active, some will do so on every cycle so long as the
rung is active, some when the rung is inactive, etc.

Input Commands

e Normally Open
e Normally Closed

e Compare

Output Commands

e Qutput
e [Viove

e Math
e Timer/Counter
® Reset
e Send Message

Input Commands

Input commands are used to determine the state of the rung: active or inactive. If there exists at least
one path from the left side of the rung to the right where all input contacts are active, then the Output
Commands on that rung will be executed.

o Normally Open
e Normally Closed

e Compare
Normally Open Command
RE&E:0,10

Description | An input command whose condition is true when the addressed bit value is active.

Type Input

Parameters | Address — the referenced bit to read from. (Ex. IN:1, OUT:2, TC:2.TM).

Usage Read

File Types All Boolean Types. (BIN, IN, OUT, CB, Register Bits, TC Attributes, XLK:UP.IN, etc.)
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Normally Closed Command

Description | An input command whose condition is true when the addressed bit value is inactive.

Type Input
Parameters | address — the referenced bit to read from (Ex. IN:1, OUT:2, TC:2.TM).

FileTypes | Aj| Boolean Types. (BIN, IN, OUT, CB, Register Bits, TC Attributes, XLK:DN.IN, etc.)

Compare Command

A command whose condition depends on the logical comparison of the values of two

referenced files.

Type Input

e Argl — The first argument (referenced file or constant) for comparison. (Ex. 10,
REG:5, “text”, BAR:8,10).

e Arg2 — The second argument (referenced file or constant) for comparison. (Ex. 10,
REG:5, “text”, BAR:8,10).

e Operation — The logical comparison to make between the 2 arguments.

Description

Parameters » Equal ( =) - true if the 2 arguments are equal.

> Not Equal( != ) —true if the 2 arguments are not equal.

> Greater Than ( > ) —true if Argl is greater than Arg2.

> Less Than ( <) —true if Argl is less than Arg2.

> Greater Than or Equal to ( >= ) — true if Argl is greater than or equal to Arg2.
> Less Than or Equal to ( <= ) — true if Argl is less than or equal to Arg2.

FileTypes | Numerical values (REG, FLT, CW, GREG). Timer/Counter .PR .AC Attributes.

Examples
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Output Commands

The following Commands are all only usable in the last position on each rung. Usually, when at least one
path of conditions on a rung are true, the output command for that rung will be activated. The exact
triggering behavior may depend on the specific command used though: some will perform an action on
switching from inactive to active, some will do so on every cycle so long as the rung is active, and some
when the rung is inactive. It is possible to have multiple output commands activated by the same rung
by using Branches.

e Qutput Coil
e [Vlove
e Math

e Timer/Counter

o Reset

e Send Message

Output Coil Command

BIM:4

o This command sets the addressed bit to true or false. When the rung condition is true,
Description | the addressed bit or output is set to true (1 or high) and with rung condition false, the
bit or output is set to false (0 or low).

Type Output Coil

e Address — the referenced bit value to write to (Ex. Out:1, REG:5.3, etc).
e Output Type — Controls the behavior of the command.

» Normal () — If the rung is true, it writes 1, otherwise it writes 0.

IN.OUT

Options

> Latch (L)—Ifthe rungis true, it writes 1 every time the rung is executed, otherwise
if the rung condition is false, it does nothing.

WB3-0UT:5
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» Unlatch ( U ) — If the rung is true, it writes 0 every time the rung is executed,
otherwise if the rung condition is false, it does nothing.

REG:2.7

» Pulse — If the rung condition change from false to true, the output is set to 1. The
next time the command is executed, the output will be set to 0. If no change in
rung condition, it does not do anything.

V(5)}-DIR

» Latch on Rising Edge — If the rung condition change from false to true, the output
is setto 1. If no change in rung condition, it does not do anything.

> Latch On Falling Edge — If the rung condition change from true to false, the output
is set to 1. If no change in rung condition, it does not do anything.

V(1)-MTR1

» Unlatch On Rising Edge — If the rung condition change from true to false, the
output is set to 0. If no change in rung condition, it does not do anything.

¥LE:DN.OUT

> Unlatch On Falling Edge — If the rung condition change from false to true, the
output is set to 0. If no change in rung condition, it does not do anything.

» Toggle On Rising Edge — If the rung condition change from false to true, the output
is inverted (0 to 1, or 1 to 0). If no change in rung condition, it does not do
anything.

© 2025 Vital Systemes, Inc. 51 www.VitalSystem.com



http://www.vitalsystem.com/

MTAL

=:Systems inc EtherCAT. ™ IntelleCAT PLC/Gateway

REG:1.5

» Toggle On Falling Edge — If the rung condition change from true to false, the output

is inverted (0 to 1, or 1 to 0). If no change in rung condition, it does not do

anything. This type of command only effects the output when the rung condition
changes.

File Types

Boolean files (BIN, OUT, CB, GBIN), Register Bits (REG:#.x, CW:#.x, GREG:#.x), Interlock (

eg XLK:DN.OUT XLK:UP.OUT ...)

Timer/Counter Command

The Timer/Counter command makes use of either a Timer or Counter register for its
functionality

Parameters

Description
e Timer — The timer register keeps timing until the preset value (in milliseconds) is
reached.
e Counter — The counter register keeps counting until the reset value is reached.
Type

Output

e ID — The timer or counter that is bound to this command.

e Preset — A 32-bit integer value that specifies when the command
stops timing/counting. For timers, this value is in milliseconds.

e Type — Controls the behavior of the command.

0N Delay Timer

NOTE: Timers increment the “Accumulator” value every millisecond, while
Counters increment the “Accumulator” value every time the rung state
transitions from false to true.

Types:

ON DELAY — This timer starts timing when the rung condition becomes true. As long as
the rung condition is true, the accumulator keeps on timing until it reaches the preset
value. When the Accumulator is equal to Preset, the ‘Done’ bit is set and the Timing bit
is reset. The Timer Enable bit will always equal the rung state. The Done bit, Timing Bit
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and Enable Bit are reset as soon as the rung state becomes false. The Accumulator is
reset to O until the rung condition becomes true again.

Rung State
Enable Bit

| Tirning Bit

Done Bit

L

Time

ON Delay Timing Diagram

OFF DELAY - This timer starts timing while the rung condition

is false. When the rung state transitions from true to false,
the Accumulator keeps incrementing until the preset value is
reached or the rung condition becomes true again. The
enable bit follows the rung state, while the Done bit is a
combination (logical ‘OR’) of the Enable and Timing bits. The Timing and Done bits are
reset when the Accumulator reaches the Preset value.

Fung State
Erable Bit

| Tirmirgy Bit
Dane Bit

Time

OFF Delay Timing Diagram

UP COUNT — The “UP Counter” counts every rung state transition
D 1 from false to true until the Preset value is reached. Each

Preset 300 transition of rung condition from false to true is registered by
Accum 0 incrementing the Accumulator by 1. When the Accumulator value
becomes equal to the Preset value, the Done bit is set to true. The Enable Bit follows
the rung condition. The “UP Counter” can only be reset with “Reset contact”. At reset,
the Accumulator value and the Done Bit are set to zero. Please refer to Timer/Counter
Reset element.
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File Types | 1¢

Move Command

Description | Copies a specified source file’s value (or a constant numerical value) into a specified
destination file while the rung is active.

Type Output
e Source — The referenced file or constant value to be moved (Ex. 5000, 0.056, REG:9,
Parameters CW:10, etc).
e Destination — The file where the source file’s value is written (Ex. FLT:2, REG:9,
CW:10, etc).

File Types | Numerical Values. (REG, FLT, CW, GREG)

Move Range Command

Description Copies a range of Files starting with the specified source address to the specified
Destination address. The amount copied is specified by the Count.

Type Output
e Source — The referenced file or constant value to be moved (Ex. 5000, 0.056, REG:9,
Parameters CW:10, etc).
e Destination — The file where the source file’s value is written (Ex. FLT:2, REG:9,
CW:10, etc).

FileTypes | Numerical Values. (REG, FLT, CW, GREG)

In the listed example, 10 files are being copied from the address starting at CW:0 to the
Example address starting at REG:3. Below is shown the Property window for this command. The
range of values from CW:0 to CW:9 will be copied to the range of REG:3 to REG:12. This
command is highly useful when many values need to be moved at once.

© 2025 Vital Systemes, Inc. 54 www.VitalSystem.com



http://www.vitalsystem.com/

-—-'=='sy;t[;néi:n[é EtherCAT. * IntelleCAT PLC/Gateway

v Command: MoveRange

SourceStart CW:0
Destination>tart REG:3
Count 10

Crelamn CWI - CWY
SrcRange Lyl - LeE

DieztR ana Ef2:3 Eiz:17
DestRa ge Clola - hElalls

Math Command

o Performs binary and unary mathematical operations (depending on how many
Description | ;-0uments were specified) and writes the result to a specified destination file while the
rung is active.

Type Output

e Argl — The first argument. (Ex. FLT:4, 5000, 4.556, REG:9, CW:10, etc)
Arg2 — The second argument. (Ex. FLT:4, 5000, 4.556, REG:9, CW:10, etc)
Destination — Address of File to store the result. (Ex. FLT:4, REG:9, CW:10, etc)

Binary Operation — operation to perform between the two arguments. All Bit
manipulation values must be done with REG (integer) values.

NOTE: When using Float type for bitwise operations, the digits
after decimal point are dropped, eg. FLT:4 BitAND 123.

None — the result is the value of Argl. Arg2 is ignored.
Addition

Parameters Subtraction

Multiplication

Division
Power/Exponentiation
BitAND — Bitwise AND

BitOR — Bitwise OR

BitXOR — Bitwise Exclusive OR

BitShiftLeft — Shifts Argl’s bit value by a specified number of digits (Arg2’s
value) to the left.

BitShiftRight — Shifts Argl’s bit value by a specified number of digits (Arg2’s
value) to the right.

YV V V VY VY Y V VYV

A\
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e Unary Operation — operation to perform on the result of the Binary Operation.
» None

Negative — Negates the value.

Bitwise Inversion — Invert the bit value.
Absolute — Absolute value.

Square Root

Sine

Cosine

Tangent

Cosecant

Secant

Cotangent

VV V V VYV Y VY VYV YV

Natural Logarithm

A\

Common Logarithm

File Types | Numerical Types. (REG, FLT, CW)

Reset Command

| MReser 7o i

Description Resets a timer or counter when the rung state transitions to true.
Type Output

Parameters e Address — The Timer/Counter to reset. (Ex. TC:3, TC:7 etc)
File Types TC
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Send Message Command

Type: Smart3G

Sends a message over Ethernet to another device or PC Host. Data and parameters determined by
control words. When the rung condition switches to true, data in the send-buffer will be sent to the
receive buffer of the destination device that has been specified by the Send Address Control Word.

Description
NOTE: This command only triggers when the rung state transitions to true.
Type Output
e Type
> Interlock — This type sends the data specified by the source address field over an interlock.
This allows Conveyor Sections to send up to 2 Integers over Interlocks. Refer to the XLK
FileType section for more information on this SendMessage Type.
Interlock Channel Which Interlock Channel to send the Message over
Source Address The start address of the data we want to send
Count How many Files we want to send in this message (Max 2)
> IntellECAT — This type sends an explicit message to another IntellECAT Gateway. Sends all 8
Control Words in the Send Buffer to the destination device.
» Smart3G - This type sends an explicit message to a Smart3G Card. Sends only 6 Control Words
in the Send Buffer to the destination device. Note that each Control Word sent will be
Parameters truncated to fit in the range of 0-255.

Control Word Expected Value

Send Address CwW:20 1-250. Last digit of IP Address.
Send Buffer CW:22 - CW:29 o IntellECAT — Any integer

e Smart3G - 0-255
Receive Address | CW:30 1-250. Last digit of IP Address.
Receive Type Cw:31 Specifies type of sender:

e IntellECAT - 80

e Smart3G - 67

Receive Buffer CW:32 - CW:39 e IntellECAT — Any integer
e Smart3G - 0-255
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Control Bit Expected Value
Receive Flag CB:10 Set to true when a new message is
received. Clearing this bit is left to
the user.

VII. Protocols
When the IntellECAT is in Gateway Mode, it will not run any ladder logic. Instead all GX20 control
cards on the network will be commanded by a connected Master PLC.

When the IntellECAT is in PLC Mode, it will run user defined ladder programs. The state of all GX20
control cards on the network will be commanded by these ladder programs. A Master PLC may be

connected to and exchange arbitrary data with the IntellECAT for use within the ladder programs.

The supported protocols for these Master Connections are described and explained on the following
pages.
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Ethernet/IP

Here are the recommended settings for the Ethernet/IP connection:

Add Class1 Connection

— Originator-> T arget [0-» T] Connection Parameters ——

I'IUU
™ Cormection Tag I

Data Size [bytes) |4D v Funddle Header

— Target->Originator [T->0] Connection Parameters ——

¥ Cornection Point |1D1
" Conmection Tag I

Data Size [bytes) |1 B4 [ Run/ldie Header

— Configuration
Configuration Instance: I‘I

Module Configuration D ata - Each byte iz & 2 char
hex value, separated by a space (i.e. Oa 26 f9).

— Connection R ate

0-»T Packet Rate [ms]: |1DD—
T-»0 Packet Rate [ms]: I‘IDD—
0-»T Production Inhibit Timeout (me): ID—
T-»0 Production Inhibit Timeout (ms): ID—

— Connection Type
0-+T Tranport Type: IF'oint To Paint 'I
T-+0 Tranport Type: Im
Transport Trigger: m
Timeaut Multiplier: 16 -
T-»0 Priority: Im
0-»T Pricrity: Im

Ll

W

[~ Keep TCP connection active during conhection

ak I Cancel

Control Word
40
Control Word
41

Control Word
59

Outputs
Speed
Outputs

Speed
Outputs
Speed
Outputs
Speed

Outputs
Speed
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Word 60
Control

Word 61

Control

Word 79

inputs  (IENICERNNN
Outputs

Speed

Online

Status

inputs  |IENIGEIGANN
Outputs

Speed

Online

Status
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Here is an explanation of the values in the above table:

Control
Word

Values written to and read from the IntellECAT for use in ladder programs. These bytes
are unused in Gateway Mode.

Speed

Percentage value from 0 to 100 command the speed of this the Device’s motors

Outputs

Bit

Usage

M1 Enable

M2 Enable

Dir M1, M2

Dir M2 (Future)

Inputs

®w
-+

N o o b WN RO

Usage

PE1

PE2

Fault 1

Fault 2

M1 Enable

M2 Enable

Dir M1, M2

Dir M2 (Future)

VIIl. Example

Getting Started:

Step 1:

Connect IntellECAT with your PC using EtherNet cable > Power it up with 24v > Connect GX20 control
cards with IntellECAT Gateway/PLC > make sure they are all powered up.

Step 2:

Open VSLogix > Press the connect button located at the menu bar

This will find the IntellECAT board in the network. Select it and press connect in the Connection Settings

window.
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0 -0 -0 - 0 Manual Connect

Metwork Map
192,168,921 192168010 1521880, 4 [*

Intellecat 51

Auto-Assign |P Scan Connect

Cancel

Step 3:

When the IntellECAT Gateway/PLC is connected, go to Device List in Project Explorer > Select the GX20
control cards in their respective ID.

ID is the number you can see on the devices rotary switch. If the ID is 21, select GX20 next to 21 in EtherCAT
Profile under Device Editor. You can add description of the device if necessary.

21 |GX20 v
22 |GX20 v | Second GX20
23 |GX20 Vi
24 |GX20 v
25 |GX20 v
26 | GX20 v

Now, your IntellECAT will be able to communicate with the GX20 Control Cards if the ID is correct. You
will be able to see the status of all the GX20 control cards under PLC Status View section in EtherCAT tab.

Taking advantage of Conveyor Types templates:

Here is a step-by-step example of designing a simple ladder program by creating a conveyor type and
use it as a template.
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Step 1:

Right click on Conveyor Types node>create new>give a suitable name to the Conveyor Type
This will open a ladder editor where you can design your ladder program.

Step 2:

If you want to use your conveyor type as a template, it has to be able to communicate with the previous
and/or next conveyor section. So, make sure your program has XLK file types.

XLK:UP.IN

This file type is the state of box available from the previous conveyor section and ready to pull in into
the current conveyor section.

XLK:UP.IN

2—| OFF Delay Timer

D 1

TRAY TRAY
APPROACHING APPROACHING
SYSTEM TIMER FOR

ZONE 1

Preset 1500
Accum 0O

XLK:UP.OUT

This file type sends the ready status of current conveyor section to the previous conveyor section. When
both XLK:UP.IN which is box available to bring in to the current conveyor section and XLK:UP.OUT which
is ready to accept box from the previous section are active, package should move from previous section

© 2025 Vital Systemes, Inc. 62 www.VitalSystem.com



http://www.vitalsystem.com/

MTAL

ystems inc

EtherCAT.

IntelleCAT PLC/Gateway

to current section by turning on the zone motor output.

Photo Eye 1 TRAY
APPROACHING
TIMER FOR
ZONE 1

0-51

Singulation Photo Eye 1

fpam—=———

Photo Eye 1 Motor 1

XLK:DN.IN

XLK:UP.OUT

)_

Zone 1 Ready

This file type is the state of next conveyor section. If there is a box in current zone and XLK:DN.IN is in
ready state, the motor of current zone should turn on to deliver the package from current zone to next

zone.

TRAY Photo Eye 1
APPROACHING
TIMER FOR
ZONE 1

0-51 XLK:DN.IN

| AEE——

Photo Eye 1 DOWNSTREAM
CONTROLER
READY

Start Up Run Photo Eye 1
Timer

XLK:DN.OUT
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This file type sends current conveyor section status to next conveyor section. If there is a box in the
current zone, XLK:DN.OUT status becomes active which means there is a box ready to deliver to the next
section.

XLK:DN.OUT

Photo Eye 1 TRAY EXITING
CONTROLER

When both XLK:DN.IN and XLK:DN.OUT are in sync, the package should move from current section to
the next section.

Ready to accept box Ready to accept box
XLK:UP.OUT XLK:DN.IN
DN »UP DN »UP
XLK:UP.IN XLK:DN.OUT
Box is ready Box is ready

Step 3:

When the ladder programs for different conveyor types are ready, go to the Conveyor Layout page. Drag
as many conveyor sections you need from Conveyor Types and name the sections accordingly.
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i ] Man Ladder

E‘mh Conveyor Types (1/31)

: E 1ZoneAcc \ | D

: Conveyor Layou\ | ra g
=-%ll Conveyor Instances (2/31) | |

ﬂ; 1ZoneAcc 0
.2 1ZoneAcc 1

1ZoneAcc 0 1ZoneAcc 1

Step 4:

Right click on each Conveyor Sections > Edit Device Map > Select which GX20 control cards will be used in
that Conveyor Section.

Step 5:

If the Conveyor Flow is from left to right, select the left conveyor section > Press “D” in keyboard, then
select the right conveyor section > Press “U” in keyboard. This step completes the interlock between two
sections and shows the conveyor flow using an arrow.

1ZoneAcc 0 1ZoneAcc 1

DN »UP

Thus, you can add as many conveyor sections you need for your entire conveyor plant and connect them
using interlock so that they communicate with each other and keep the conveyor flow active.
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